We have already featured the Generate Design tool in Volume 15(3) and in 19(1-3). The tool resembles the Formula tool but is much more powerful, dealing with those regular arrangements of layer thicknesses, and/or packing densities, that are impossible to represent compactly as a formula. We are prompted to return to this tool by two recent papers on thickness modulation of designs. [O. Lyngnes and J. Kraus, Design of optical notch filters using apodized thickness modulation, Appl Opt 53(4), A21-A26 (2014), and J. Zhang, Y. Xie, X. Cheng, H. Jiao, and Z. Wang, Thin-film thickness-modulated designs for optical minus filter, Appl Opt 52(23), 5788-5793 (2013)]. Both, instead of apodizing the layer indices, as in a rugate, modulate the thicknesses. There are scattered references to thickness modulation in the literature but


Lyngnes, and Perilloux in his book, demonstrate a Gaussian form of thickness variation, while Zhang uses linear, quintic and sinusoidal functions.

All these forms are equally straightforward, but for demonstration let us choose a sinusoidal apodizing function similar to Zhang. The design uses Air
as incident medium, BK7 glass as substrate, and 48 layers with nondispersive indices of 1.47 and 2.25. The reference wavelength is not explicitly defined but appears close to 525nm. Zhang’s designs use a basic halfwave for a second order notch peak. The thicknesses of the layers are given as:

\[
T = t_o + 0.5t_p A(l) \sin(\pi l + \varphi)
\]

\[
A(l) = \sin(\pi l/s)
\]

where \(T\) is the \(l\)th layer optical thickness, \(t_o\) is the average layer thickness, that is, in this case, a halfwave, 0.5, \(l\) is the layer number, \(s\) the total number of layers and \(t_p\) the modulation amplitude. \(A(l)\) is the apodizing function. The sine term in the first row simply alternates the modulation sign. The low-index layer next to the incident medium is a quarterwave acting as a matching layer. Note that the layer numbering convention we will use has layer 1 next to the incident medium, opposite to that in the paper.

The Generate Design tool dialog is shown in Figure 1. The upper part contains basic information on the materials, the reference wavelength and the number of layers. Angle units can be set to degrees or radians. (We prefer degrees.) The lower part of the dialog contains the code fixing the layer attributes. The predefined variables are listed as comments (! denotes a comment).

There are two parts to any statement: an optional condition terminated by a colon followed by an assignment terminated by a semicolon. The tool executes the statements in turn. For each layer all statements are executed in sequence. If a condition is true, the corresponding assignment is made.

Figure 1 includes the statements to produce the Zhang design in equation (1). Before any other layer properties are assigned, the correct symbol (H or L in this case) must be applied to each layer. The modulo operator, \%, giving the remainder of division, allows us to write conditions for the odd and even layers as shown. Since a quarterwave is assigned to each symbol that is the initial thickness of each layer.

L and N are equivalent to \(l\) and \(s\) respectively. We denote \(t_p\) by \(t\). Since we are working in degrees, 180° replaces \(\pi\). We prefer \((2 \times (L \% 2) - 1)\) to give +1 for an odd and -1 for an even layer. Apodization is not applied to the first layer. It remains as a low-index quarterwave hence the condition \(L <> 1\). The first statement defines \(t\) as the modulation amplitude and assigns a value of 0.25. Since Zhang does not specify a value, the 0.25 is a product of trial and error. Figure 2 shows the performance and matches virtually exactly the characteristic in the paper.

Let us now look at a more involved design. We are often faced with the design of a coating to have two separated reflection peaks. Of course this can readily be accomplished by placing one quarterwave stack over another, but this requires many layers and we all know the problems of magnified electric fields that occur in the outer stack when the inner stack is reflecting. Often the reflectors are also expected to handle high power densities. Chapter 5 of Perilloux’s book. “Quarter-wave Stack Transformation” is particularly useful in this respect and describes a powerful method that we have seen nowhere else. Chapter 5 alone, is a good reason to possess this book.

A structure, usually called a period, the optical thickness of which is a whole number of halfwaves, will yield a zone of high reflectance when repeated a sufficient number of times, unless the period is an absentee. The HL period of the quarterwave stack is a good example. Let us now turn to our problem of designing a reflector for two wavelengths, \(\lambda_0\) and \(\lambda_1\), where \(\lambda_1\) is larger than \(\lambda_0\). A possible design would be a repeated period that is a whole number of halfwaves for both wavelengths, but an absentee for neither. However, we still have to obtain the correct reflectances, and this is the power of Perilloux’s method. We will illustrate the technique with a simple example, also in the book, of high and equal reflectances at 1000nm and at 1500nm.

We neglect dispersion and start with two separate quarterwave stacks, each tuned to one of the two wavelengths, denoted in Figure 3. First, we make sure that the optical thickness of a whole number of halfwaves in one stack is set equal to a whole number (different) of halfwaves in the other. To achieve this, we may sometimes have to adjust the wavelengths slightly with the consequence that those specified may not be at the exact center of their reflecting bands. We can also include dispersion, if

(Continued on page 3)
As $k$ varies from zero to unity, the reflectance at $\lambda_0$ falls and that at $\lambda_1$ rises. Finally, some trial and error involving $k$ and the total number of layers will achieve the desired performance. This approach is readily implemented in the Generate Design tool.

How do we set this up? The code is shown in Figure 4. For clarity, no attempt has been made to compact the code. We can conveniently use the same materials as we did for the notch. 42 layers and a $k$ value of 0.565 complete the design, Figure 5.

Figure 6 shows the electric field distributions. At both wavelengths the field at the front surface is low and there is no field magnification through the thickness of the coating.

(Continued from page 2)

necessary. In this particular case, six quarterwaves of the lesser wavelength are exactly equal to four quarterwaves of the greater. Perilloux’s method, then, is gradually to morph one quarterwave stack into the other, using a parameter, $k$, that retains the halfwave conditions and adjusts the relative reflectances.

The method begins in Figure 3. The two stacks are aligned at either side each showing equally thick periods, A and B, made up of a whole number of halfwaves. The region in between the periods shows the way in which the layers of the period will vary linearly with $k$, all the time retaining the same total optical thicknesses of the periods. Some layers expand and others contract and vanish. The way to accomplish this will usually be obvious. An analytical approach is outlined in the book.

![Figure 3](image3.png)

Figure 3. The arrangement of the two stacks and the transformation from one to the other depending on the parameter $k$ that ranges from zero to unity.

\[
k = 0.565;
L \% 2 = 1: \text{Layer} = H;
L \% 2 = 0: \text{Layer} = L;
L \% 6 = 1: \text{LayerOpticalThickness} = 0.25 \times (1.0 + 0.5 \times k);
L \% 6 = 2: \text{LayerOpticalThickness} = 0.25 \times (1.0 - 0.5 \times k);
L \% 6 = 3: \text{LayerOpticalThickness} = 0.25 \times (1.0 - k);
L \% 6 = 4: \text{LayerOpticalThickness} = 0.25 \times (1.0 + 0.5 \times k);
L \% 6 = 5: \text{LayerOpticalThickness} = 0.25 \times (1.0 - 0.5 \times k);
L \% 6 = 0: \text{LayerOpticalThickness} = 0.25 \times (1.0 + 0.5 \times k);
\]

![Figure 4](image4.png)

Figure 4. The code for the dual wavelength reflector. The value of $k$ is set manually in the first row.

As $k$ varies from zero to unity, the reflectance at $\lambda_0$ falls and that at $\lambda_1$ rises. Finally, some trial and error involving $k$ and the total number of layers will achieve the desired performance. This approach is readily implemented in the Generate Design tool.

How do we set this up? The code is shown in Figure 4. For clarity, no attempt has been made to compact the code. We can conveniently use the same materials as we did for the notch. 42 layers and a $k$ value of 0.565 complete the design, Figure 5.

Figure 6 shows the electric field distributions. At both wavelengths the field at the front surface is low and there is no field magnification through the thickness of the coating.

![Figure 5](image5.png)

Figure 5. The dual peak reflector with 42 layers. Reflectance at 1000nm and 1500nm is 99.93% with a $k$ value of 0.565.

![Figure 6](image6.png)

Figure 6. The field distributions at 1000nm and 1500nm are similar to a classical quarterwave stack.
We discussed the Report Generator in detail in the first issue of this current volume and anticipated that version 9.9 of the Essential would enable the inclusion of graphics, such as logos, in reports and printouts. Let us look at simple printouts first.

For the simple print command, the graphic should be of the correct size. It can be saved in a variety of formats, bmp, gif, jpg, wmf (Windows Metafile) and emf (Enhanced Metafile). The Print tab in the General Options dialog is where we will specify the graphic. Figure 7. The header and footer fields are where the text is specified, the left, center and right texts being separated by the upright bar character "|". Note that if text and graphic are specified in the same location, the graphic will be overwritten by the text. The Graphics... button next to the text field gives access to the Header and Footer Graphics dialog where the file containing the graphic is to be entered. As a verification of the file, an indication of the graphic is displayed on the right, but not necessarily with the correct aspect ratio. In the example shown, the logo is on the left of the footer, and, just as a demonstration, the required text is specified as Thin Film Center|Page %d

Figure 7. Shows how to arrange a graphic or logo in the footer of printouts. The logo should be saved as a file in one of the stated formats in the text. The file will be identified in the Footer Graphics or Header Graphics dialog. If text is specified in the same position it will overwrite the graphic.

(Continued on page 6)
As he emerged from the elevator, James could see the student waiting by the door of his office and carrying some papers.

“Right,” said James once they were settled on either side of his desk, “what is the problem?”

“In yesterday’s class you were explaining about the pseudo-Brewster angle exhibited by metal layers,” answered the student, “that is the dip in the curve of $p$-reflectance versus angle that has a similar shape to a dielectric but doesn’t drop anywhere near zero. I have the curve for silver that you showed us.” Here the student showed James the curve, Figure 8.

“I decided to try to make a measurement of it,” continued the student, “and there was a front surface silver mirror in the lab cupboard that seemed ideal. I borrowed that and made some quick measurements.”

At this point the student showed James Figure 9.

“The curves are not exactly the same, but they do have a similar shape.”

“Well,” said James, “what is worrying you about them? Maybe the silver is not quite pure.”

“What worries me,” explained the student, “is that I am sure my measurements, and especially the two polarizations, are correct, but the $s$ and $p$-polarization curves are inverted. It is the $s$-polarization that shows the dip.”

“I wondered if you would notice that,” chuckled James. “Do you not understand the reason?”

James proceeded to explain.

What was James’s explanation?

Please turn to Page 7 column 1 for the answer
such as the organization name, especially if a rather special font is preferred.

Reports are much more flexible than printouts. Even if they contain essentially the same information, virtually any desired appearance can be assured by powerful formatting commands. For inclusion in reports, the logo, or graphic, can be saved in the same variety of formats as for the printout.

There will be occasions when a graphic should be embedded in the body of the report. The necessary command is

```
%<Graphic <FileName> Parameters %>
```

where Parameters can be any or all of: width, height, center, left, right, with their obvious meaning, width and height being followed by their value in inches. Note that there is no command that retains the aspect ratio of the original graphic and so, if this is important, the width and height commands must be chosen correctly to preserve it.

If the graphic is to be used as a logo in the header or footer it should be of the correct size. The header and footer commands do not include any parameters. They are the following:

```
%< LeftHeaderGraphic <Filename> %>
%< CenterHeaderGraphic <Filename> %>
%< RightHeaderGraphic <Filename> %>
%< LeftFooterGraphic <Filename> %>
%< CenterFooterGraphic <Filename> %>
%< RightFooterGraphic <Filename> %>
```

Figure 10 shows the footer resulting from the use of the LeftFooterGraphic command. It was followed, in this case, with:

```
%<Footer |Thin Film Center Inc|Page %d %>
```

The Page Layout Instructions section of the Report Generator chapter of the manual includes instructions on embedding graphics.

---

You are working on a special antireflection coating. Each time you open a new design you laboriously alter the materials, targets, performance parameters to suit the current design task, each time the same. You feel that there ought to be a better way. You are correct. There is a better way.

Once the various details have been entered and with the design active, select Set as Default Design in the Options menu. From now on, the current design details, even including the arrangement of the columns, will be the default attributes. You can repeat the process as often as you like. You do not even need to save the current design.

The default design is maintained in the current Materials database. If you are using a job then the default goes with the job.

`Chart Styles...` in the Options menu is another particularly useful item. This assigns the various default colors, widths and symbols that are used in plots. You don’t like blue for s-polarization and red for p? This is where you can change that. Then when plotting over an existing plot, there is a sequence of line styles that is used. Members of the sequence can be removed in this dialog.

Many of the analysis tools plot or tabulate the chosen attribute against Distance from Medium, which is equivalent to depth into the coating. Distance from Medium is subject to the same layer thickness hierarchy as the rest of the package. If the optical thickness column is present in the design document then Distance from Medium will be given in terms of optical thickness. If the optical thickness column is missing but physical thickness is present then Distance from Medium will be in units of physical thickness. Then, finally, if only the geometric thickness column is shown it will take precedence. The columns can be added or removed by the Display Setup tool in the File menu.
“The problem,” explained James, “is that your silver mirror has a protecting dielectric overcoat, most likely of silica.

“An admittance diagram is probably the easiest way towards understanding the effect. We will use the modified admittances that are normalized to preserve the admittance of the incident medium at \( y_0 \).

“The modified admittances of a high performance metal like silver are very close to:

\[
\begin{align*}
\eta_s &= (n - ik)/\cos \theta_0 \\
\eta_p &= (n - ik) \cos \theta_0 
\end{align*}
\]

and so as the tilting increases the \( s \)-admittance of the silver moves away from the origin while the \( p \)-admittance moves towards it. These movements pull the circular dielectric loci with them and, provided the layer is not too thick, the loci will look something like those in Figure 11, where, to make it clearer and easier to interpret, the figure has been somewhat distorted from the shape that would correspond to the true optical constants of silver.

“A thickness of around a quarterwave or so is enough to cross over the real axis into the first quadrant of the complex plane at normal incidence, but thin enough for the end of the shrinking \( s \)-admittance locus to cross back into the fourth quadrant at some elevated tilt angle at which point, or close to it, we have the minimum reflectance.

“The termination of the corresponding \( p \)-admittance locus for the same thickness of overcoat simply moves towards the origin and the \( p \)-reflectance rises continuously, as in your measurement.”

“That certainly explains it,” said the student. “I can also see that if we have the absolutely correct thickness of dielectric then at a quite high angle of incidence we can actually have the locus termination exactly at \( y_0 \) giving zero reflectance.”

“Correct,” answered James, “it is a quite narrow resonance at close to grazing incidence and the paper that was first to recognize that (with a completely different analysis technique) is: M. Nevière and P. Vincent, *Brewster phenomena in a lossy waveguide used just under the cut-off thickness*, Journal d’Optique 11, 153-159 (1980).

“Now here is a challenge for you. It is also possible to have a similar narrow resonance for \( p \)-polarization. Does the overcoat have to be thicker or thinner than for the \( s \)-resonance?


“I’ll think about it,” said the student, “and thank you so much, as always, for your help.”

[Note: The silver used by the student was indeed coated with just under a quarterwave of silica.]
The course, given by Angus Macleod, covers thin-film fundamentals and lasts around five hours. It is available on DVD so that it can be played on a computer. The set is accompanied by a pdf file summarizing the content. There are seven lectures with titles and durations:

1. Complex numbers 31 mins
2. Complex waves 20 mins
3. Optical admittance 37 mins
4. Admittance transformers 29 mins
5. Applications 59 mins
6. Matrix method 71 mins
7. Oblique incidence 60 mins

The price for the complete set is $600 (US) plus shipping.

Short Course News

We will be running a variety of short courses this year, in Asia, Europe and USA. Please check our web site: http://www.thinfilmcenter.com/schedule.html
As details become firm they will be posted there.

MacLeod Medium
is prepared exclusively for members of their Update Service by
Thin Film Center Inc
2745 East Via Rotunda, Tucson, Arizona 85716-5227, USA
Tel: (520) 322 6171 Fax: (520) 325 8721
info@thinfilmcenter.com www.thinfilmcenter.com

Topics in Optical Coatings

A collection on DVD of short video introductions to various aspects of optical coatings. Each video is essentially a stand-alone presentation that does not rely on the others except that there are certain conventions and definitions that may be assumed. For that reason the Fundamentals video that deals with basic issues and sets the scene for the videos is included, at no extra charge, with any combination of the others. They are formatted as *.mov files intended for use on either a PC or an Apple machine. This new set differs completely from the existing Short Video Course (see column 1) and supplements rather than replaces it.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fundamentals</td>
<td>Included</td>
</tr>
<tr>
<td>Introduction to Coating Design</td>
<td>$125.00</td>
</tr>
<tr>
<td>Basics of Ultrafast</td>
<td>$125.00</td>
</tr>
<tr>
<td>Basics of Rugates</td>
<td>$125.00</td>
</tr>
<tr>
<td>Topics in n and k Extraction</td>
<td>$125.00</td>
</tr>
<tr>
<td>Color in Coatings</td>
<td>$125.00</td>
</tr>
<tr>
<td>The Complete Set</td>
<td>$600.00</td>
</tr>
</tbody>
</table>

We will be running a variety of short courses this year, in Asia, Europe and USA. Please check our web site: http://www.thinfilmcenter.com/schedule.html
As details become firm they will be posted there.

Write, call, fax, e-mail or visit our web site for more details of videos or courses.